DIGITAL VOICE
RECORDER

DS-3300

ONLINE
INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.
Please read these instructions for information
about using the product correctly and safely.
Keep the instructions handy for future reference.

——————————————————————————————————————
To ensure successful recordings, we recommend that
you test the record function and volume before use.




Table of Contents

Table of Contents ........ccccevveviirienecneene. 2
Safe and Proper Usage ..........ccccevveeenenen. 4

General Precautions

1 Getting Started

Main Features ........cccceeviiieiiiiie e, 9
xD-Picture Card ........ccceevieiiiieiiieiee 10
Identification of Parts 11
Installing Batteries .... .
Charging Battery .........cccceeviviivenneene
Information Regarding Rechargeable
Batteries ......ccccoviiiniiiiee e 16
Turning ON the Recorder ..........cccceenee 17
Power Save Mode
Dealer Option Items ........ccoccveevecivieenns 18
CUSTOM Button (Programmable) ........ 18
Setting Time/Date (TIME&DATE) .......... 19
Inserting and Ejecting a Card ............... 21
Recording .......ocovviiiiiiiiieecee e, 23
Microphone Sensitivity (MIC SENSE) ... 27
Recording Modes (REC MODE) ........... 28

Using the Variable Control

Voice Actuator (VCVA) ....cccceeevenneens 29
Hands-free Recording .. 30
Recording Monitor ..........ccccoveiniieeeennnnes 30
Playing .....ccooieiiiie e, 31
Erasing .....coccoevvoiiiiie 33
Menu List .. 37
Learning to Use the Menu .................... 38
Locking Files (LOCK) ......cccceviiiiiiienis 39
Index Marks .......cccoceviiiiiiiiiiie e, 40
LCD Display Information .............ccc.c..... 41
Setting Priority Levels......... ... 43
Setting Job Data .........ccccveeviiiiiieeiieee 44
Setting Option ltem .......cccoooiiiieiiiiees 46
Formatting the Card (FORMAT) ............ 47
HOI e 49

4 Preparation Before Using
DSS Player
DSS Player Software ..........ccccceeveecueennene 50
Installing DSS Player Software ............. 52
Uninstalling DSS Player Software ......... 53

Download from Www.Somanuals.com. All Manuals Search And Download.



Using Online Help ......cooevviiiiiiiieee, 54
Connectionto Your PC ........cccoociveinenne 55
Running DSS Player ....

Window Names.........cceeeeveeeeiiiiiciiiiieeees

5 Managing Files on Your PC

Download Dictation Files

from the Recorder ............ccocernene. 61
Playing a Dictation File ............ccccceeeennnee 63
Upload Dictation Files to the Recorder ... 64
Direct Recording/Editing on PC ............ 65
Changing User ID (Author ID) ..66
Changing a Folder Name ..........ccccceee.. 67
Editing File Comments ...........cccccveeenen. 67
Using Voice Recognition

Software (Optional) ........cccceeueenen. 68
Joining Files.....
Splitting Files

USB Microphone/USB Speaker ............ 76
Sending Dictation Files/
Receiving Document Files .............. 77

Download from Www.Somanuals.com. All Manuals Search And Download.

6 Using the Recorder as a

Reader / Writer
Using the Recorder as a

Reader/Writer .........cccevervenenivenenne 88

7 Other Information n

Alarm Message List ........ccccceveriiieeininnns 89
Troubleshooting
Accessories (Optional) ........cccoeeveereenne 91
Specifications .........ccoceeviriiiiniienen 92
Technical Assistance and Support ........ 93

L4
L5
L6

w



Safe and Proper Usage

Before using your new recorder, read this
manual carefully to ensure that you know
how to operate it safely and correctly.
Keep this manual in an easily accessible
location for future reference.

Important Safety Precautions

Certain symbols are used in the user’s
manual and on this product to help
protect users, their surroundings, and
their property from possible injury or
damage. Please familiarize yourself with
the following definitions and meanings
for each symbol before reading the
precautions.

Signifies danger which
may result in serious
injury or death.

Indicates items or actions
which may cause serious
injury or death.

Warning

Indicates items or actions
which may resultin damage

Caution ©rpersonal injury.

Symbols prohibiting a specific action

. Do not
® Prohibited @ disassemble

Symbols requiring a specific action

. Unplug from
0 Mandatory % power outlet

Convention Used In this Manual

¢ The word “card” is used to refer to the xD-
picture Card.

* The word “DSS Player” is used to refer to
the DSS Player Pro Dictation Module in
Windows environment and DSS Player in
Apple Macintosh environment.

* The Notes at the bottom of a page are used
for additional information, exceptions, or
related events.

* Words in uppercase form such as PLAY or
REC are used to describe a function,
button, or switch position on the recorder.

* The icon []]l,; indicates that feature or
setting can be modified by Professional
Olympus Authorized Dealer only.
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General Precautions

® Do not leave the recorder in hot, humid
locations such as inside a closed
automobile under direct sunlight or on
the beach in the summer.

® Do not store the recorder in places
exposed to excessive moisture or dust.

® Do not use organic solvents such as
alcohol and lacquer thinner to clean the
unit.

® Do not place the recorder on top of or
near electric appliances such as TVs or
refrigerators.

@ Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause
interference and noise. If you
experience noise, move to another
place, or move the recorder further
away from such equipment.

® Avoid sand or dirt. These can cause
irreparable damage.

@ Avoid strong vibrations or shocks.

® Do not disassemble, repair or modify
the unit yourself.

@ Do not operate the unit while operating
a vehicle (such as a bicycle,
motorcycle, or go-cart).

@ Keep the unit out of the reach of
children.

<Warning regarding data loss>

Recorded content in memory may be
destroyed or erased by operating
mistakes, unit malfunction, or during
repair work.

It is recommended to back up and save
important content to other media such as
a computer hard disk.

Batteries/Rechargeable
Battery Pack (BR402)

/\ Danger

* Do not solder lead wires or terminals
directly onto a battery or modify it.

* Do not connectthe @ and © terminals
together. This may cause fire,
overheating or electric shock.

* When carrying or storing the battery
(BR402), be sure to put it in the provided
case to protect its terminals. Do not carry
or store the battery with any metal objects
(such as key rings). If this warning is not
followed, fire, overheating or electric
shock may occur.

* Do not connect the batteries directly to
a power outlet or a cigarette lighter of
an automobile.

* Do not insert the batteries with their P
and © terminals reversed.

¢ If any liquid from a battery gets into your
eyes, promptly wash it off with clean
water and consult your doctor at once.

* There is a hole from which gas escapes
on the @ terminal. Do not cover or block
it (BR402).

/\ Warning

* Batteries should never be exposed to
flame, heated, short-circuited or
disassembled.

* Do not attempt to recharge alkaline,
lithium or any other non-rechargeable
batteries.

* Never use any battery with a torn or
cracked outer cover.

Download from Www.Somanuals.com. All Manuals Search And Download.



* Keep batteries out of the reach of
children.

¢ If you notice anything unusual when
using this product such as abnormal
noise, heat, smoke, or a burning odor:

@ remove the batteries immediately while
being careful not to burn yourself, and;

@ call your dealer or local Olympus
representative for service.

*Do not expose the rechargeable
batteries to water. Do not allow water to
contact the terminals.

* Do not remove or damage the battery
insulating sheet.

* Do not use the batteries if you find
something wrong with them such as
leakage, color change or deformity.

¢ Unplug the charger if the charging is still
incomplete after the specified time it
should take.

¢ Should any battery liquid get on skin or
clothing, promptly wash it off with clean
water.

* Keep batteries away from fire.

A\ Caution

* BR402 rechargeable batteries are
exclusively for use with Olympus digital
voice recorder DS-3300. Do not use
them in combination with other
equipment.

* Do not subject batteries to strong
shocks.

* Do not use with other types of batteries,
or with batteries that have different
voltages or brand names.

e When using more than two batteries,

* When using new batteries, or batteries
which have not been used for a long
time, be sure to recharge them even if
they were only used for a short period
of time.

Battery Charger (Cradle)

/\ Danger

* Do not attempt to use this charger
with anything other than Olympus

Ni-MH batteries. Using it in
combination with other batteries
may cause fire, explosion, leakage
or overheating.

Do not put the charger in water.
Using it when wet orin ahumid area
(such as a bathroom) may cause
fire, overheating or electric shock.

Do not use the charger with

® batteries that have been
inserted with their @ and ©
terminals reversed. This may
cause fire, explosion, leakage,
overheating or damage to
batteries.

Never modify or disassemble

the charger. This may cause
Do ot fire, overheating, electric
disassemble shock or injury.

/\ Warning

* Do not use the batteries if you
find something wrong with

them such as deformity or
leakage. This may cause

i explosion or overheating.
6 charge thm&%mwmgomanuals.com. All Manuals Seargh Andrbownload. 9



¢ Do not insert metal wires or
® similar objects. This may
cause fire, overheating or

electric shock.

* Keep out of the reach of

0 children. Do not let children

use this product without adult
supervision.

/\ Caution
® * If charging is not completed (if

the charging indicator is not
turned off) after 3 hours, plug
the power-supply cord out.
Contact the store of purchase
or Olympus Service Station
for repair since it may be a
malfunction.

Be sure to charge batteries
0 within the temperature range

of 0°C - 40°C/32°F - 104°F. If
not, there may be explosion,
fire, leakage or damage to
batteries.

Do not put anything heavy on
the charger or leave it in an
unstable position or in a
humid place. This may cause
explosion, fire, leakage,
overheating, electric shock or
injury.

Do not touch the charger for
too long when using it. This
may cause a serious low-
temperature burn.

@

if the charge indicator light
does not go off) after three
hours, the charger may break.
If this occurs, disconnect the
power plug and consult your
nearest Olympus dealer or
customer support center.

* Do not use or store the
charger in/on an unstable
place, such as a television set,

etc. If it falls, it may cause
injury or break.

0 * If charging does not finish (or

AC Adapter

/\ Danger
0 * Be sure to use the charger with

the proper voltage (AC 100 - 240
V). Using it with other voltage
levels may cause fire, explosion,
overheating, electric shock or
injury.
* For safety, be sure to unplug the
% charger from the outlet before
performing maintenance or

Unplug from . .

poweroutiet  Cleaning. Also, never plug in or
disconnect the power plug with a
wet hand. This may cause electric
shock or injury.

/\ Warning

* Do not attempt to disassemble, repair
or modify the AC adapter in any way.
* Keep foreign objects including water,
metal, or flammable substances from
etting inside the product.
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* Do not moisten the AC adapter or touch
it with a wet hand.

¢ Do not use the AC adapter in the vicinity
of flammable gas (including gasoline,
benzine and lacquer thinner).

In case

¢ ... the internal parts of the AC adapter
are exposed because it has been
dropped or otherwise damaged:

e ... the AC adapter is dropped in water,
or if water, metal flammable substances
or other foreign objects get inside it:

e ... you notice anything unusual when
using the AC adapter such as abnormal
noise, heat, smoke, or a burning odor:

@ do not touch any of the exposed parts;

(@ immediately disconnect the power
supply plug from the power outlet, and;

® call your dealer or local Olympus
representative for servicing. Continued
use of the AC adapter under these
circumstances could result in electric
shock, fire or injury.

/\ Caution
* Do not use the charger if the
® power plug is damaged or the
plug is not completely
connected to the outlet. This
may cause fire, overheating,

electric shock, short circuit or
damage.

¢ Unplug the AC Adapter from
% AC outlet when not using. If
this precaution is not
U - .
pgv"’,'e“rgofl:;’lg follow_ed, fire, overheating or
electric shock may occur.

0

0

N

* Make sure to hold the plug
when removing the power
plug from the outlet. Do not
bend the cord excessively or
put a heavy object on it. This
may cause fire, overheating,
electric shock or damage.

If something appears to be
wrong with the charger,
unplug the charger from the
outlet and consult your
nearest service center. Using
the charger may cause fire,
overheating, electric shock or
injury.

Do not use or keep the charger
in very hot places, such as in
direct sunlight, in a closed car
on a sunny day, near a heater,
on an electric carpet, etc. Do not
use the charger if something is
covering it (such as a blanket).
This may cause fire, explosion,
leakage or overheating.
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Main Features

Dual function cradle, docking station, for
recharging of the optional Ni-MH
Rechargeable Battery Pack (BR402)
(= P.14)*"and for downloading data from
the recorder to a PC (== P.61).

The recorder has multi programmable
button (CUSTOM) (== P.18).

Recording and storing voice in DSS
format.

Two recording modes, SP (Standard
Playback) mode or LP (Long Playback)
mode (== P.28).

Five folders and up to 199 files/folder, for
a maximum of 995 recordings (= P.23).
Built-in Variable Control Voice Actuator
(VCVA) function (= P.29).

USB Audio Device, recorder can be used
as a USB microphone or USB speaker
when connected to a PC (== P.76).*2
Large LCD screen with backlight.
Multi-level priority setting (== P.43).

DSS Player software included (= P.50).

Hands-free recording function when used with
the optional foot switch (RS25/26) (== P.30).

** Available only with the optional Ni-MH Rechargeable
Battery Pack (BR402).

*2 Do not use with Windows 98 as computer operation may
become unstable.

IBM and PC/AT are the trademarks or registered
trademarks of International Business Machines
Corporation.

Microsoft and Windows are registered trademarks
of Microsoft Corporation.

Apple, Macintosh, iMac, eMac, Mac, and
PowerMac are trademarks or registered
trademarks of Apple Computer, Inc.

Intel and Pentium are registered trademarks of Intel
Corporation.

Adobe and Acrobat Reader are registered
trademarks of Adobe Systems Incorporated.

Other product and brand names mentioned herein
may be the trademarks or registered trademarks
of their respective owners.
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xD-Picture Card

The xD-Picture Card is a removable recording media.

Compatible Cards

Y
OLYMPUS @

The removable card can be used to store different
kind of data. Since the card has larger memory
capacity than a diskette, it can be used to transfer
data between different PCs. The recorder supports

xD-Picture Card

cards with memory capacity between 16 to 512 MB. @ Index area @ Contact area
You can write Comes into
down the card’s contact with the
contents. recorder’s signal

read contacts.

Memory Sizes of Cards and Approximate Recording Times*!

Memory Size SP Mode LP Mode
16MB 2 hr. 35 min. 5 hr. 30 min.
32MB 5 hr. 13 min. 11 hr. 00 min.
64MB 10 hr. 25 min. 22 hr. 20 min.

- - *1: Available recording time for one continuous file.
128MB 20 hr. 55 min. 44 hr. 45 min. Available recording time may be shorter if
256MB 42 hr. 00 min. 89 hr. 40 min. many short recordings are made.

- - *2: Total recording time of two files. The maximum
512MB 84 hr. 05 min. 179 hr. 30 min.*?

recording time per file is 99 hours.

Notes

* When initializing (formatting) a card, confirm that no necessary data is stored on the card
beforehand. Initialization completely erases the existing data on the card.

* Cards used in a recorder must be formatted in the same recorder first unless formatted with a
CAMEDIA series Olympus digital camera. Card may not perform as expected when formatted by a
different device.

* The card has a service life. When reaching the end of its life, writing or erasing data on the card will be
disabled. In this case, replace the card.

* If you use a PC card adapter compatible with the card to save or delete some data on the card, the
maximum recording time on the card may be decreased. To recover the original recording time, initialize/
format the card in the recorder.

* Olympus will not be held liable for any data corruption or loss due to misuse of the media card.
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Identification of Parts

I

(D EAR (Earphone) jack
(@ MIC (Microphone) jack
(3® Built-in microphone
(@ NEW button

(5 HOLD switch

(® REC (Record) button
(@ REW (Rewind) button
FF (Fast Forward) button
(® INDEX button
FOLDER/MENU button
@ Built-in speaker

12 STOP button

13 PLAY button
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ERASE button

15 CUSTOM button
(Programmable)

Display (LCD panel)

@ Record/Play indicator lamp

POWER (ON/OFF) switch

VOLUME (+) button

VOLUME (-) button

@) Card cover

@ Card cover lock

@3 Battery cover

PC (USB) terminal/Cradle
attachment point

11



Display (LCD Panel)

sued Jo uoneayuap| =
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117
0&@@

@ Battery indicator

@ Folder

© Priority indicator

O Current file number

© Total number of recorded files in
the folder

O Erase lock indicator

@ Character Information display

O Microphone sensitivity display

© VCVA (Variable Control Voice
Actuator) indicator

@ Record mode indicator
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Installing Batteries

| AAA alkaline batteries |

Lightly press down on the arrow and slide the
battery cover open.

Insert two AAA batteries, observing the correct
polarity.

Close the battery cover completely.

Replacing batteries

The battery indicator on the display changes as the batteries
lose power.

o > N > €3 > T

When d__N] appears on the display, replace the batteries
as soon as possible.

When the batteries are too weak, the recorder shuts down
and “BATTERY LOW” appears on the display.

Notes

* Be sure to turn OFF the recorder before replacing the batteries. Removing the batteries while the
recorder is in use may corrupt the card. If you are recording into a file and the batteries run out, you will
lose your currently recorded file since the file header will not be written. Itis crucial to replace the batteries
when one hash mark in shown in the battery icon.

* Be sure to replace both batteries at the same time.

* Never mix old and new batteries, or batteries of different types and/or brands.

« If it takes longer than 1 minute to replace dead batteries, you may have to reset the time when you load
new batteries.

* Remove the batteries if you are not going to use the recorder for an extended period of time.
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| Ni-MH Rechargeable Battery Pack (BR402) (Optional) |

An optional Ni-MH Rechargeable Battery from Olympus can
be used for the recorder.

Lightly press down on the arrow and slide the
battery cover open.

Insert Ni-MH Rechargeable Battery Pack,
observing the correct polarity.

Close the battery cover completely.

The battery needs to be charged when you use the recorder
for the first time after purchase (=P.15).

Recharging battery
The battery indicator on the display changes as the battery
loose power.

aw] > o > N > ]
When {_ ¥ appears on the display, charge the battery as soon
as possible.
When the battery is too weak, the recorder shuts down and
“BATTERY LOW” appears on the display.

Notes

* The Olympus Ni-MH Rechargeable Battery Pack (BR402) is sold separately.

* Removing the battery pack while the recorder is in use may corrupt the file. If you are recording into a file
and the battery run out, you will lose your currently recorded file since the file header will not be written. It
is crucial to charge the battery once you see only one hash mark in the battery icon.

* Remove the battery pack if you are not going to use the recorder for an extended period of time.
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Charging Battery

You can charge the Ni-MH Rechargeable Battery Pack (BR402) in the recorder when you set the recorder
in the cradle. The battery is usually shipped partially charged. You need to charge the battery before first
use.

— — - A511/D-7AC (Optional) - — — Connect the optional AC adapter (A511/D- 2
| AC cable 7AC) or USB cable to the cradle. &
AC adapter o A For connection procedures, see P.57. g

| ( When using the adapter for charging, connect the g
| g power plug to the charger’s AC connector. %
<

| connector |

| The plug type varies

depending on the

| country where sold.

L |

Turn ON the recorder and set it vertically
in the cradle.

CHARGE indicator lamp glows red and the charging
starts.

AC cable The lamp goes out when the charging is complete.

CHARGE
indicator lamp

Notes

¢ The Olympus AC adapter (A511/D-7AC) is sold separately.

» Charge the battery often for first few uses. Battery performs better after several full charge/discharge cycles.

* Ni-MH battery pack (BR402) is only chargeable with the Olympus AC adapter A511 or D-7AC.

« If you charge the battery right after charging is complete, it will take only few minutes to charge the battery.

¢ The PC must be ON when charging battery via the USB cable connection.

* Charging battery via the USB cable connection may not be successful depending on the power supply
capacity of your PC. Use the AC adapter instead.

« If you change the recorder to AUDIO device while charging battery only via the USB cable connection, charging may stop.

* Do not set or remove the recorder from the cradle while it is in operation.

* You can charge the battery while the recorder is in operation. '| 5
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Information Regarding Rechargeable Batteries

These batteries are exclusively for use with Olympus voice recorder DS-3300. Never use them
in combination with other equipment.

Discharging

Batteries self-discharge while they are not in use. Be sure to charge them regularly before use.

Battery life

Charging and discharging are possible for approximately 500 times depending on usage.

| Operating temperature

Batteries are chemical products. Battery efficiency may change even when operating within
the recommended temperature range, but this is not a malfunction.

| Recommended temperature range for use |

Discharging (when using appliance): 0°C - 50°C/32°F - 122°F

Charging: 0°C - 40°C/32°F - 104°F

Storage: —20°C - 30°C/-4°F - 86°F
Using the batteries outside the above temperature range may result in declining efficiency
and shorter battery life.
In order to prevent battery leakage or rust, remove the batteries from the products when you
will not be using them for a long time, and store them separately.

salaneg ajqeabieyosay Buipiebay uonew.oju] =

Notes

This charger is designed to fully charge batteries regardless of their energy level. However, for best

results when charging newly purchased batteries or batteries that have not been used for a long

time (more than one month), It is recommended to fully charge the batteries, then discharge them.

Repeat two or three times.

* When you dispose dead batteries always observe the laws and regulations regarding the disposing of such items.

« If Ni-MH rechargeable batteries are not fully discharged, protect against short-circuiting (e.g. by taping
the contacts) before disposing.

@ Batterij niet For customers in Germany

: Olympus has a contract with the GRS (Joint
: weggoolen, maar Battery Disposal Association) in Germany to
inleveren als KCA. ensure environmentally friendly disposal.

16
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Turning ON the Recorder

With the battery charged in the recorder and the card
inserted properly, the recorder is ready to work.

While the power switch on the back of the recorder is in
the OFF position, none of the buttons or switch on the
recorder will be active. Slide the power switch to the ON
position to activate the recorder.

SPOJ\ OABS JoMOd [19p1098Y ayl NO Buiuing

Power Save Mode

When the recorder is ON but not in use for 10 minutes, by default, it will switch to power save
mode automatically. To reactivate the recorder again, press any of the buttons on the recorder.

17
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Dealer Option ltems

Some additional options can be set by your Olympus Professional Dealer.
These additional and customisable options are as follows:

® Setting for “beep” sound.

® Setting for NEW button operation.

® Setting for REC button operation.

® Setting for Splash screen.

® Adding/removing of user defined fields.

® Switching the display languages.

® Changing the number of folders.

® Assigning functionality to CUSTOM button.
@ Assigning functionality to the foot switch.
® Setting time for Power save mode.

@ Setting to lock the file automatically on completion of recording.
@ Setting for intervals of acceleration when using CUE and REV.

® Setting to select the AUTHOR ID when the recorder is turned on.

For details on the functions and operation
of dealer optional items, consult your
Olympus dealer.

m CUSTOM Button (Programmable)

=)

The CUSTOM button can be assigned two kinds of functions by being pressed in different
ways. By default, the button is programmed on PRIORITY for both ways:

Default Operation
Press the CUSTOM button.
Press and hold the CUSTOM button.

PRIORITY button

CUSTOM The following functions can be assigned to CUSTOM button.

button - DISPLAY button

(Programmable) - mecording Mode setting button
- Microphone Sensitivity setting button
- VCVA setting button
- PRIORITY setting button

ST
P
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Setting Time/Date (TIME&DATE)

Setting the correct time and date on the recorder is very important since every file recorded on
the recorder will have the date and time information as part of the file header. This will simplify

the file management aspects later on.

Proceed from step 1.

The hour indicator will flash automatically when you load batteries before using the
recorder for the first time, or after the recorder hasn’t been used for a long time.

CUSTOM —

ol | FrREW

the data button '
displayed) (alters a choice)

FOLDER/MENU button

(accepts a choice and moves on to
the next item)

Set the hour.
@ Press the FF button or REW button to
set the hour.
(@ Press the REC button to accept the hour.
* You can choose between 12 and 24 hour
display by pressing the CUSTOM button
while setting the hour and minute.

Example: 5:45 P.M.

5:45 PM «— 17:45
(Initial setting)

Set the minute.

@ Press the FF button or REW button to
set the minute.

(@ Press the REC button to accept the
minute.

Set the year.
@ Press the FF button or REW button to
set the year.
(@ Press the REC button to accept the year.
* You can choose a different date format by
pressing the CUSTOM button while setting
the date.
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Example: March 14, 2005 Set the day.
@ Press the FF button or REW button

3M 14D 2005Y (Initial setting) to set the day.
l (@ Press the REC button to accept the
14D 3M 2005Y day’s date.
N OO
2005Y 3M 14D Notes
* |f you press the STOP button during the setup
Set the month. operation, the recorder will save the items that
@ Press the FF button or REW button to were set to that point.
set the month. * You can set the time and date from your PC using
(2 Press the REC button to accept the month. DSS Player software (s= P.50).

Changing the Time/Date

Press and hold the FOLDER/MENU

button for 1second or longer.
The menu appears (== P.37).

Press the FF or REW button until @@=
“TIME&DATE” in SUB MENU flashes
on the display.

BEEP

Press the REC button.

Time/Date screen appears. The hour
indicator flashes, indicating the start of the
Time/Date setup process.

Follow the same steps starting at step 1 in
“Setting Time/Date” (== P.19).

Press the FOLDER/MENU button to
close the menu.
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Inserting and Ejecting a Card

Inserting a Card

Slide the card cover lock in the direction

indicated by the arrow.

The card cover is unlocked and the message “CARD COVER
IS OPEN” appears on the display. When this message
appears, the power is switched off automatically.

Face the card the correct way and insert it into
the card slot as shown in the diagram.

« Insert the card keeping it straight.

* The card stops with a click when it is inserted all the way.

¢ Inserting the card the wrong way or at an angle could
damage the contact area or cause the card to jam.

* If the card is not inserted all the way, data may not be
written to the card.

Close the card cover securely.

Card inserted fully into the slot

The message “PLEASE WAIT” on the display flashes for
seconds.

Card not inserted fully into the slot

When the card cover is closed, the message “INSERT
CARD?” on the display flashes for a few seconds. Pressing
any button will sound beeps* and flash the message
“INSERT CARD” again.

* When the system sounds are enabled.

Notes

« If an unformatted card is inserted, the recorder automatically displays the menu to menu format option (=
P.47).

* Never use any card in the recorder unless it has been formatted on this unit or on a CAMEDIA series Olympus

digital camera (= P.47).
g I%wnloa(% from Www.Somanuals.com. All Manuals Search And Download.
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Ejecting a Card

Make sure the recorder is STOP mode.

Slide the card cover lock in the direction
indicated by the arrow.

The card cover is unlocked and the message “CARD
COVER IS OPEN” appears on the display.

The power is switched off automatically.

Push the card inward to unlock it, and let it
eject partially.
The card is visibly out of the slot and can be removed safely.

Hold the card straight and pull it out.

Note
Releasing your finger quickly after pushing the card inward may cause it to eject forcefully out of the slot.

Download from Www.Somanuals.com. All Manuals Search And Download.



Recording

By default, the recorder has five folders, I, &1, (!, b1, [ and you can select folder by

pressing the FOLDER/MENU button. These five folders can be selectively used to distinguish
the kind of recording; for example, Folder Y might be used to store private information, while
Folder [E1 might be dedicated to holding business information. You can use your DSS player to
change a folder name (= P.67). Up to 199 messages can be recorded per folder.

All recordings made in any of the folders will be in Digital Speech Standard (DSS) format. By

default, the RECORD function is configured to record at the current position (overwrite). However,
that can be changed to any of the following settings:
* Append: Appends the recording to the end of the current file.

* Insert: Inserts the recording at the current position in the file.

* Overwrite: Overwrites the recording starting at the current position in the file.

New Recording

Create a new file to record in.

Press the NEW button to create a

new file.

(@ Current recording mode
(® New file number

© Selected Author ID

Press the REC button to start

recording.
The record/play indicator lamp glows red.
Aim the microphone at the sound source.

@ Current recording time
(®© Remaining recording time

Press the STOP button to stop

recording.
If you want to append additional recordings
to the same file, press the REC button again.

© _o®
BT Y

4H33M12S

&

QWG' ;]

AUTHOR A
‘4H33M07S

I}
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Press the REC button while recording.
w» “REC PAUSE” will flash on the display.
* The recorder stops when it has been left paused for 10 minutes or longer.

| Resume Recording |
Press the REC button again.
W Recording will resume at the point of interruption.

Notes

* A beep will sound when the remaining recording time reaches 60 seconds, 30 seconds, and 10 seconds
while recording.

* “MEMORY FULL” or “FOLDER FULL” will be displayed when the memory or folder capacity is full. Delete
any unnecessary files before recording any further (s P.33) or transfer dictation files to your computer
using DSS Player Software (x== P.58).

* You cannot select a different recording mode (SP or LP) than that of the original file when appending
recording.

Review Recording

Press the REW button while recording, and release it when you want to start playing a file.
The recorder plays up to the end of file, then stops.
You can overwrite or append additional recordings in the same file from that point.
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Overwrite Recording

You can overwrite a previously recorded file from any point within the file.
Note that the overwritten recordings will be erased.

Select and play the file you want to
overwrite.

Stop playback at the starting point of
overwrite.

Buipiooay H

Press the REC button to start @E']
overwriting. eI /33
The record/play indicator lamp glows red. AUTH%N/I\ZS s

14M00S
RO

Press the STOP button to stop
overwriting.

Note
You cannot select a different recording mode (SP, LP) than that of the original file before overwrite recording.

25
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Insert Recording

Additional recording can be inserted into previously recorded file.

Select and play the file you want to
insert an additional recording into.

While playing the file, press the
FOLDER/MENU button to insert an

additional recording.
“INSERT ?” appears on the display.

Press the REC button to start

inserting an additional recording.

The record/play indicator lamp glows red.
“INSERT REC” and the remaining
recording time will alternate on the display.

Press the STOP button to stop
inserting the additional recording.

lmE.:{'l/?“l

AUTHOR A

OZMZSS

zﬁ "f/s#

AUTHOH A

DDDDDDIIIIII

I []

Notes

* The recording time and date of the file is updated to the time and date of the inserted recording.
* You cannot select a different recording mode (SP, LP) than that of the original file before inserting.
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Microphone Sensitivity (MIC SENSE)

Microphone sensitivity is adjustable to meet recording needs.

Press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (= P.37).

Press the FF or REW button until “MIC =
SENSE” flashes on the display.

REC MODE
MIC SENSE
EXIT

SUB MENU

Press the REC button.
The microphone sensitivity setup process

begins.

Press the FF or REW button to choose =
between “CONF.” and “DICT.”.

CONF.: High-sensitivity mode that records MLLE 2b

sounds in all directions.
DICT.: Low-sensitivity mode suited for
dictation.
Press the REC button to select the
option.

Press the FOLDER/MENU button to
close the menu.

Note

If you want to record clear or noise-free dictation, select DICT mode and place the microphone 5 to 10 cm
(2 to 4 inches) from the source.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Recording Modes (REC MODE)

The recording mode can choose between SP (standard recording) and LP (long-term recording).

Press and hold the FOLDER/MENU =

button for 1 second or longer.
“REC MODE” will be displayed on the RAL R
éﬂ)l((IDTSENSE

screen (= P.37).

Press the REC button.
The recording mode setup process begins.

Press the FF or REW button to
choose between “SP” and “LP”.

Press the REC button to select the
option.

Press the FOLDER/MENU button to
close the menu.

Note
Choose SP mode for recording meetings or lectures with crisp clarity.
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Using the Variable Control Voice Actuator (VCVA)

When the microphone senses that sounds have reached a preset actuation volume level, the built-in Variable
Control Voice Actuator (VCVA) starts recording automatically, and stops when the volume drops below the actuation
level. The VCVA feature helps extending recording time and conserves the memory by turning off recording
during silent periods. This helps make the playback, with no lulls or dead space, more efficient and convenient.

Set the VCVA in the menu to ON (== P.37-
38).

Press the REC button to start recording. fSs) 4
DN
1331134

When the sound volume is lower than the preset P

actuation sound level, recording automatically stops after AUTHOR A
1 second approximately, and “STANDBY” flashes on the
display. The record/play indicator lamp glows when LI L]

recording starts and flashes when recording pauses.

Adjust the Start/Stop Actuation Level

Press the FOLDER/MENU button during
recording.
The VCVA level screen is displayed.

Press the FF or REW button to adjust the :]
actuation level. 1334

The VCVA level can be set to any of 15 different AUTHOR Asis

values. The higher the value is, the more sensitive A 0

the recorder can react to sounds. At the highest

value, even the faintest sound will activate recording.

The VCVA actuation level can be adjusted according

to the ambient (background) noise.

(@ Start level (varies according to the sound
volume being recorded)

@ Level meter (moves to the right/left according
to the set level)

(VADA) Jojenioy 8210 [013u0) ajqetiep ay) buisn

Notes
* The start/stop actuation level also varies depending on the selected microphone sensitivity mode (== P.27).
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Hands-free Recording

The recorder can be used as a hands-free recording device. To setup the recorder for hands-
free operation, connect the optional Olympus foot switch (RS25/26) to the back of the cradle
and place the recorder in the cradle as shown in the diagram below.

The default settings of the foot switch functions
are as follow:

Default settings

Switch Press Press and hold Release
FF NEW - -
LISTEN - REC STOP
REW - REV PLAY

Notes

¢ The Olympus foot switch (RS25/26) is sold separately.

* Make sure the recorder is STOP mode before connecting it to the cradle for hands-free recording.

* To record with better quality using the hands-free recording function, set the microphone sensitivity to
"CONF." mode, or use an external microphone.

Recording Monitor

Itis possible to monitor your recording by listening to the
recording while recording is in progress. Insert the
earphone plug into the earphone jack and use the
ij_ VOLUME VOLUME button to control the volume level.

/]

(/)

button

Note
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Playing

You can start playing a file at any point.

Select the file, then press the PLAY

button to start playback.
The record/play indicator lamp glows
green.

(@ Current playback time
(@ Total recording time of the file being
played

Press the VOLUME (+) or VOLUME

(=) button to adjust the volume.
The display shows the volume level. You
can choose between 0 to 30.

Press the STOP button at any point
you want to stop the playback.

®

AUTHOR A
—————00M

=
L0 3
05S

LENGTH :
———27M58S
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Playback functions

Playback Operation How to Cancel
functions

Fast Press the FF button once while stopped. Press the PLAY button.

Forward = The recorder starts the operation of
(FF) the set position.

Rewind Press the REW button once while stopped.

(REW)

Cue Hold the FF button while stopped or playing a file. Release the FF button.

(CUE)

Review Hold the REW button while stopped or playing a file. Release the REW button.
(REV)

 If you press the FF button once while fast-forwarding or twice while stopped, the recorder will stop at the
end of the file (F.SKIP).

 If you press the REW button once while rewinding or twice while stopped, the recorder will stop at the
beginning of the file (B.SKIP). If the REW button is pressed within 2 seconds, the recorder skips to the
beginning of the previous file.
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Erasing

Erasing a File
Erasing or deleting a file from any of the folder on the recorder is a very simple process.

Select the file you want to erase. n
L
D
Press the ERASE button. = £
“FILE ERASE ?” flashes on the display for ;' c' f/,‘gg @

FOLDER A

FILE
ERASE ?

o
B i

FOLDER A

ERASE |

2
(o

FOLDER A

ERASE DONE

approximately 8 seconds.

2,3-

Press the ERASE button once more
while “FILE ERASE ?” is flashing.
The display changes to “FILE ERASE !” and
erasing will start.

“ERASE DONE” is displayed when the file is
erased. File numbers will be reassigned
automatically.

Notes

« |f the ERASE button is not pressed within the 8 seconds after “FILE ERASE?” starts flashing, the recorder
will revert to the stop status.

* An erased file cannot be restored.

* Locked files cannot be erased (= P.39).

3
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Erasing All Files in a Folder
All files in a folder can be erased simultaneously, except for locked files (== P.39).

T

FOLDER A

ALLERASE ?

T

FOLDER A

ALL ERASE'!

- L 2
EJﬂ/aa

FOLDER A

ERASE DONE

Select any file in the folder, then
press and hold the ERASE button for
3 seconds or longer.

“ALL ERASE ?” flashes on the display for
approximately 8 seconds.

Buise.3 =

Press the ERASE button once more
while “ALL ERASE ?” is flashing.
The display changes to “ALL ERASE !” and
erasing will start.

1,2-

“ERASE DONE” is displayed when the files
are erased. Any locked files in the folder will
be reassigned new file numbers in ascending
order.

Notes
« If the ERASE button is not pressed within the 8 seconds after “ALL ERASE ?” starts flashing, the recorder

will revert to the stop status.
* The erasing process may take up to 10 seconds. Do not interrupt this process! Data will be destroyed.
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Partially Erasing a File

You can erase a selected file in part.

Start playback the file you want to
erase partially.

Press the ERASE button at the point
to start erasing.

While playback continues, “PARTIAL
ERASE” and the file length will alternate
on the display.

Press the ERASE button at the point
to end erasing.

The erase starting point (time) set in step
2 and the ending point (time) set in this step
will alternate on the display for 8 seconds.

o] 34ad

AUTHOR A

ERASE
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Press the ERASE button to confirm @E :]
erase. 0ocl_13 134

The display changes to “PARTIAL ERASE!” AUTHOR_ A

i i . PARTIAL
and erasing will start

When “ERASE DONE” appears on the display, (=T

partial erase is complete. QnmEL’:i’]

AUTHOR A

ERASE DONE

Buise.3 =

Notes
« If the ERASE button is not pressed within the 8 seconds after “START” or “END” starts flashing, the

recorder will revert to the stop status.
¢ An erased file cannot be restored.
* Locked files cannot be partially erased (s= P.39).
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Menu List

I Press and hold the FOLDER/MENU button for 1 second or longer.

(_MENU )

N

REC MODE Select SP or LP mode (x=P.28).

Microphone sensitivity setting. Select between
MIC SENSE CONF (high-sensitivity mode) or DICT (low-
sensitivity mode) (w=P.27).

EXIT Exit MENU and return to STOP mode.

SUB MENU Switches to the SUB MENU.

VCVA setting (=P.29). Select ON (enabled)

L1

- VCVA or OFF (disabled).
N LOCK Locking files setting (=P.39). Select ON

N

Notes

* If you press the STOP button or FOLDER/MENU button during a menu setup operation, the recorder will stop

(locked) or OFF (unlocked).

System sounds setting. Select ON (enabled)
BEEP or OFF (disabled).

It

FORMAT Recorder formatting (=P.47).

Returns to the MENU.
LCD contrast adjustment. Select the level from
1to 12.

USB charge setting. Select ON (enabled) or
OFF (disabled).

Backlight setting. Select ON (enabled) or OFF
(disabled).

Time/Date setting. Hour, minute, year, month
TIME&DATE and day (=P.19).

CONTRAST

USB CHARG.

BACKLIGHT

]

and apply the items that were set to that point.

* The recorder will stop if you leave it idle for 3 minutes during a menu setup operation, when a selected item is

not applied.

Press the FF
button or REW
button.

l

Press the
REC button.

* You can set jyg, 8 24% SHPRMA S ERUARAIOBORUAT IR R S BRYPAR BRSO

1s11 nuapy
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Learning to Use the Menu

To navigate through the different options in the MENU, use the MENU List flow chart (== P.37)
and the following steps to modify or change any settings.

Press and hold the FOLDER/MENU button for 1

second or longer.
The menu appears (= P.37).

Press the FF or REW button to highlight a menu
item you want to modify/change.

Press the REC button to select that menu item.
The possible options for the menu item will be in view.

Press the FF or REW button to highlight an option
or setting.

Press the REC button.
The highlighted option will be selected and the new setting
saved.

Press the FOLDER/MENU button to close the
menu.
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Locking Files (LOCK)

The file lock feature is very useful to protect important data from accidental erase. Locked files
are never erased except when the card is formatted (== P.47).

Select the file you want to LOCK,
press and hold the FOLDER/MENU

button for 1 second or longer.
The menu appears (= P.37).

Press the FF or REW button until &y
“LOCK” in SUB MENU flashes on the
display. [.SUB MENU ]

Press the REC button.
The file locking setup process begins.

(31907) sajid Bunjoo H

Press the FF or REW button to &y )

choose between “ON” and “OFF”. @ IaiLii /]
ON: Locks the file and prevents it from FOLDERLA
being edited or erased. oI

OFF: Unlocks the file and allows it to be
edited or erased.
(@ Erase lock indicator

Press the REC button to select the
option.

Press the FOLDER/MENU button to
close the menu.

Notes

¢ You cannot append, overwrite, or insert recordings into locked files (x= P.23).
* You cannot set index marks in locked files (= P.40).

39
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Index Marks

Index marks can be placed in a file during recording or playback to provide a quick and easy to

identify important sections in the file.

Setting an Index Mark

Press the INDEX button during
recording or playback to set an index

mark.
An index number appears on the display.

syJep xapuj H
=
1

Locating an Index Mark

[0

AUTHOR A

[} NDEX 08
SET

Hold the FF or REW button while
playing a file.

The recorder stops for 1 second when it
reaches the index mark.

Clearing an Index Mark

Locate the index mark you want to
clear.

Press the ERASE button while the index
number appears for approximately 2

seconds on the display.
The index mark is erased.

Notes

e
e 101 13

I NDEX 08
CLEAR

* Up to 16 index marks can be set in a file. Attempting to set more index marks will cause “INDEX FULL” to

appear on the display.
¢ Index marks cannot be set or cleared in a locked file (= P.39).
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m LCD Display Information

Before using the DISPLAY function, it should be programmed to CUSTOM button.
The LCD screen on the recorder can display 7 different formats of information by using the DISPLAY
(CUSTOM) button. This helps review and confirm different recorder settings and file information.

Use the DISPLAY (CUSTOM) button.
The LCD display will switch view every time the DISPLAY
(CUSTOM) button is used.

While in Stop or Playback Mode

Q‘_A1 When using DISPLAY (CUSTOM) button, the recorder will cycle
%Qﬂ HU through @ to @. If there is no file, only &), ® will display instead.

uonewuoyu] Aejdsiq @ =

@ File length e=m ) @=@ _ | @ Current time and date
Shows how long a file is. o HHEEE o HHEEE Shows the current time and
AUTHOR A AUTHOR A date. (During the playback
00M00S (' TIME&DATE : operation, the “TIME & DATE”
NG one SWHEEY  or the counter appears)
3 +
(@ Time stamp = ) = — ® Work type ID
Shows the year, month, |g HHEEE o 0 s Shows the selected Work Type
and date that the file was  "ATioR A ATHOR A ID.
recorded. 00MO00S 00MOO!
REC DATE : WORKTYPE :
3M16D2005Y SURGICAL
+ +
® Time stamp & ) & | ® Memory remaining
Shows the time that the file v ,'B,' /33 N ,'B,' /33 Shows the remaining recording
was recorded. AUTHOR A AUTHOR A time.
Mo0S 00MO00S
REC TIME: REMAIN :
3M16D 12:564 1H50M 128
L 2
@ File comment* &= )
Shows a comment addedto ~ |g,_| l'ﬂl'/lit *If a comment contains many
the file. (If there is no AUTHOR A characters, it will scroll horizontally
comment, “--" will appears.) COMMERMO0S to display the complete comment.

41
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While in Record Mode

@ Recording level meter
Displays the sound input
level graphically and the
remaining time available for
recording in countdown
mode.

AUTHOR A

DDD[I][IIIII

While Recording in VCVA Mode

(2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.

(@ VCVA recording level
meter
Displays the sound input
level graphically and the
remaining time available for
recording in countdown
mode.

;“
S 13+ '134

AUTHOR A

AUTHOR A

DDDDDDIIIIII

l‘s%i
S 134

(“STANDBY” appears if the VCVA actuation

level isn’t reached.)

While in Overwrite Record Mode

(2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.

@ Recording level meter
Displays the sound input
level graphically, the current
time and the length of the
file.

o

QWE' :il]

AUTHOR ID

AUTHOR ID
10M258
14MOO§

10M25S
14M00S
i}

While in Insert Record Mode

(2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode, and the current time
and length of the file.

@ Recording level meter
Displays flashing “INSERT
REC”, the sound input level
graphically, and the current
recording time.

AUTHOR 1D
1H25M01S

INSERT RE
]

(2 Remaining memory bars
Displays flashing “INSERT
REC”, the remaining time
available for recording in bar
mode, and the current
recording time.
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Setting Priority Levels

By default, CUSTOM button is programmed with PRIORITY function.

You can set a priority level on each file recorded. You can choose between high ( A ) and

normal (no indication). The default is normal.

To Set a Priority Level on an Existing File

Press or hold the PRIORITY

Select the file. T
o101 /33

oyl

AUTHOR A
00MO00S

LENGTH :
27M58S

Ed

(CUSTOM) button to choose the |ty HHIEE,

priority level. AUTHO oroos

A : High level LENGT ises

No indication: Normal level.

(@ Priority level indicator

To Set a Priority on a New File

Press the NEW button. "F‘E ! '—

A new file is created. ®ocr 43'0/@
AUTHOR_A
REMA | N:

2H33M12S

(CUSTOM) button to choose the
priority level.

A\ High level
No indication: Normal level.

Press or hold the PRIORITY @f
4'3'.'
wer_t=d /33

¢

AUTHOR A
NEW FILE
RE

MA | N:
2H33M12S

Note

Priority level cannot be chan on g locked filed (== P.39).
y CI%ownload Pronngw. omanuals.com. AI?)Manuals Search And Download.
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[[@ Setting Job Data

To operate the AUTHOR ID setting (when turn on the recorder), the recorder needs to be
additionally set to the dealer option item beforehand.
Every file recorded on the recorder will include the Author ID and Work Type as part of its
header information. To create multiple Author IDs and Work Types on the recorder, use the
bundled DSS Player software to create and upload a Job Data list (list of Author IDs and Work

Types) to the recorder.

By default the Author ID is set to “DS3300”.

Setting an Author ID

Turn ON the recorder.

When more than one Author ID exist
on the recorder, the ID list will be
displayed.

Press the FF or REW button to
select the Author ID that you
want to assign to the recorder
from the ID list.

Press the REC button to set the
ID.

All recordings made by the author
during the session will include the set
ID as part of the header information.

&=

AUTHOR: B
AUTHOR C
AUTHOR D

ID List

i T
T
T
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Setting a Work Type

Press the NEW button while in

STOP mode.

When more than one Work Type ID
exist on the recorder, the Work Type
ID list will display.

Press the FF or REW button to
highlight a Work Type from the
Work Type ID list.

Press the REC button to select
the Work Type.

All recordings made with the new Work
Type ID will have the new Work Type
as part of the header information.

1333

WORKTYPE B
WORKTYPE C
WORKTYPE D

Type List
oL Tet ]
T
T

— Type 10
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[[@ Setting Option ltem
il
The recorder can be programmed with additional user defined fields called Option Items.

Press the NEW button while in

STOP mode.
When programmed into the recorder, the
Option Item ID displays.

Use the alphanumeric characters @ﬁ :]
set displayed to set the Option Iltem 1333

ID PATI ENT NO

Characters that can be entered are from 0 3456789@AB
to 9, from Ato Z, and _.

Press the FF/REW button:
Navigate through the character set.
Press the REC button:
Enter the highlighted character and go
on to the next character.
Press and hold the REC button:
Finish entering ID.
Press the ERASE button:
Erase the characters being entered.

If multiple Option Items are programmed
into the recorder, each Option Item ID is
entered in the same way described above.
When entering the final ID is done, the
recorder switches to NEW mode.

Notes

* Each Option Item ID field can accept up to 20 characters maximum.

« If more than one Work Type ID exist on the recorder, the Option Item ID displays after determining the
Work Type.

Download from Www.Somanuals.com. All Manuals Search And Download.



Formatting the Card (FORMAT)

Cards that have been used on non-Olympus devices, or cards that are not recognized by the
recorder, must be formatted before they can be used with the recorder. The Olympus xD-
Picture Card delivered with the recorder is preformatted and ready for use.

To familiarize yourself with the formatting process, read the steps below.

Press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (= P.37).

Press the FF or REW button until =]

“FORMAT” in SUB MENU flashes on

the display.
GONTRAST

Press the REC button to select
“FORMAT”.
The formatting process is selected.

Press the FF or REW button to (]
highlight the “START” option.
[ FORMAT ]
CANCEL
Press the REC button to confirm (o]
“START” selection.
“DATA WILL BE CLEARED” appears for D/&TF;(\)RmH
approximately 2 seconds. BE CLEARED

47
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to highlight the “START” option.

initiate the formatting process.
Formatting begins and “FORMAT!” flashes
on the display.

“FORMAT DONE” displays when formatting
ends.

Press the FF or REW button again &=

SURE?
CANCEL
START

Press the REC button again to &

FORMAT!

2

(o)

FORMAT
DONE

Notes

* The time required to format cards differs depending on the capacity of cards. For example, formatting
may take about 1 minute for 512 MB card. Do not interrupt the formatting process by opening the card

cover or the battery cover. Doing so will damage the data or card.
* When the card is formatted, all the stored data, including locked files, are erased.
« If an unformatted card is inserted, the recorder automatically displays the format option in
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Hold

Setting the HOLD switch to the HOLD position.
If you set the recorder to HOLD status by sliding the
HOLD switch in the direction of the arrow, the current
conditions will be preserved, and all buttons and switches
except the HOLD switch will be disabled. This feature is
useful when the recorder has to be carried in a bag or
pocket.

Remember to reset the HOLD switch when

using the recorder.

3
o
Notes
* The display will flash if the switch is moved to hold in the stop status. At this time, if any button is pressed
the clock display will flash for about 2 seconds, but will not operate.
« If the switch is moved to hold during playback (or recording), the playback (recording) status will stay and
cannot be operated.
(When playback has ended and the recording has ended due the remaining memory being used up, it will
be in the stop state.)
49
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DSS Player Software

The DSS Player is a fully featured software tool that provides a simple to use but sophisticated
method of managing your recordings. Some of the features of the DSS Player are:

* Automatic download and backup of recordings from the recorder to a PC.

* Automatic distribution of recordings by e-mail or FTP to transcriptionists or other users.

» Automatic retrieval of typed documents, via e-mail or FTP, linking the document to the recording.

* Allows you to manage and change settings on your recorder.

* Allows you to play and edit recordings on your PC.

* When used with the recorder connected to a PC, direct recording on the PC is possible.

n Precautions on using the recorder connected to a PC

alemyos Jafkeld ssa
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® When you are downloading a file from

the recorder or uploading a file to the
recorder, do not remove the USB cable
even if the screen is indicating you can.
Data is still being transferred while the
record/play indicator lamp is blinking.
When removing the USB cable, be sure
to follow the description in ==P.56. If the
USB cable is removed before the drive
is stopped, data may not be
successfully transferred.

® On a PC, do not format the drive of the

recorder. Initialization is not successfully
achieved on a PC. For initialization, follow
the instructions in the menu screen of
the recorder (== P.37).

@ Folder (directory) names displayed by

file management tools such as Explorer
attached to Microsoft Windows and
Finder attached to Mac OS are different
from the folder names settable with the
recorder or DSS player.

@ If folders or files stored on the recorder

are moved or renamed by using a file
management tool such as Explorer or
Finder, the order of files may be
changed or files may become
unrecognizable.

@ Data can be written or uploaded to the

recorder even though the attribute of
the recorder drive is shown as Read-
only by the operating system of the PC.

@ As the noise may cause adverse effects

on electronic devices nearby the
recorder, unplug the earphone when
you connect the recorder to a PC.
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Operating Environment

Make sure that your computer meets the operating environment listed below. Please check
with your system administrator or your Olympus Professional Dealer.

PC: IBM PC/AT compatible PC PC: Power Mac G3 233 MHz
Operating  Microsoft Windows 98/ 98SE/ class processor or faster
System: Me/ 2000 Professional/ XP iMac/ iBook/ eMac/ Power
Professional, Home Edition Mac/ PowerBook “
CPU: Intel Pentium Il class 333 (The computer must support ~
MHz processor or faster a standard USB port.) 73
(Processor 500 MHz or faster Operating Mac OS 9.0-9.2.2/ 10.1-10.3 :
is recommended) System: E
RAM: 128 MB or more (256 MB or RAM: OS X e
more is recommended) 128 MB or more (256 MB or @
Hard drive 50 MB or more more is recommended) g
space: 0OS 9.x %
Drive: 2x or faster CD-ROM, CD-R, 64 MB or more (128 MB or
CD-RW, DVD-ROM drive more IS recommended)
Sound card: Creative Labs Soun_d Blaster Hard drive 50 MB or more
16 or 100% compatible space:
d card ’
) squn car Drive: 2x or faster CD-ROM, CD-R,
Browser: Microsoft Internet Explorer CD-RW, DVD-ROM drive

4.01 SP2 or later
) . Display: 800 x 600 pixels or more, 256
Display: 800 x 600 pixels or more, 256 colors or more

colors or more
USB port:  One or more free ports
USB port:  One or more free ports ]
; . . Audio 1/0 Earphone output or speakers
Audio I/lO  Microphone input and terminals:
terminals:  earphone output or speaker

Notes
* Do not use the recorder as a USB Microphone/Speaker on Windows 98 as computer operation may
become unstable. (Use only with Windows 98SE or later versions of the OS.)
* To use the voice recognition function with the recorder, use Windows 98SE or later versions of the OS (= P.68-69).
* Macintosh version does not support voice recognition software. 5]
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Installing DSS Player Software

Before you connect your recorder to your PC, you must first install the DSS Player software.
Make sure to exit all running applications, eject the floppy disk if you are using one, and logon as
administrator if you are running Windows 2000/XP (Professional only) or Mac OS X on the network.

Insert Olympus DSS Player CD
into the CD-ROM drive.

The installation program will start
automatically.

If the installation program does not start
automatically, browse your CD-ROM drive
and execute “setup.exe”.

The installation Language Selection

dialog box appears.
Select the desired language.

Register user information.

Enter your name, company name, and
license ID number (serial number).

The license ID number is printed on the
license ID card included inside the recorder
package.

Click the [Next] button. When a confirmation
dialog box appears, click the [Yes] button.

Proceed with the installation
according to the instructions on the
screen.

Insert Olympus DSS Player CD
into the CD-ROM drive.

Double-click the CD icon.
Select the folders named “Mac OS 9.x”
and “Mac OS X” and start up your OS.

Double-click the following icon.
Select the folder of which the language
is to be installed, and execute the
installation program in the folder.

Proceed with the installation
according to the instructions on the
screen.

Note
Never install DSS Player in Mac OS 9.x system, when using DSS Player with Mac OS X. The device
connected when using the classic environment may not be recognized.
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Uninstalling DSS Player Software

 Windows J  Macintosh
Exit DSS Player program. Exit DSS Player.
Click the [start] button on the Delete the Preferences file_. _
taskbar. Delete the [DSS Preference] file in the
' following location.
Select [Add/Remove programs] (0S %) e
from the [Control Panel]. I(\:I)ascgzc())sh HD : User : Library : Preferences

Alist of installed applications is displayed. Macintosh HD : System Folder : Preferences

Select [Olympus DSS Player Pro], Delete the Executable file.

then click the [Change/Remove] Delete the [DSS Player for Mac] (OS 9.x)

button. / [DSS Player] (OS X) file in the location
. . . where you installed the file.

Proceed with the uninstallation For OS X users, uninstalling has been

according to the instructions on completed. For OS 9.x users, proceed to step 4.

the screen.

Delete the Driver file.
Delete the following files in the following location.
System folder : Function Enhancement

[DSS 10USB Driver]
[DSS 10USB Shim]
[DSS 1USB Driver]
[DSS 1USB Shim]
[DSS FSUSB Driver]
[DSS FSUSB Shim]
[DSS USB Driver]
[DSS USB Shim]

(=
3
3
(7]
-
-
5
«
(=]
[7]
[72]
3
D
<
(]
=
[
o
=
=
Q
=
(]

Delete the Help file.

Delete the [DSS Player for Mac Help]
(0S9.x)/ [DSS Player Help] (OS X) file in
the following location.

System folder : Help

Note

Uninstallation does not erase stored dictation files.
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Using Online Help

For information on the DSS Player usage and features, refer to the online Help.
To start online Help:

Windows
Help Topics: Olympus DSS Player, Pro Help - Dictation Mod... [2][X]

¢ Click the [start] t_)uttqn, then select [All Programs], [Olympus ]
DSS Player], [Dictation Help].

* While DSS Player is running, select the [Help] menu,
[Contents].

* While DSS Player is running, press F1 on the keyboard.

Ciick atopic, and then click Display, O click another tab, such as Index:

@ Welcome to Dlympus DSS Player Pro”

@ Commands

@ Other Features

@ D5-3300 Specifc liems
@ Trouble Shooting

djaH auljuo buisn =

Piint Cancel
* While DSS Player is running, select [DSS Player for Mac 806 D3 Biaventiclp =
Help] (OS 9.x)/ [DSS Player Help] (OS X) from the [Help] =) @ Q- Ask a Question
menu.

ISP e

Welcome to DSS Player
Let's get Started
DSS Player Guided Tour

Troubleshooting

NEIC

Note
Online Help is available after the DSS Player is installed.
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Connection to Your PC

Be sure to install the DSS Player software before connecting the recorder to a PC. However, if
you do connect the recorder before or during the software installation, the “Add New Hardware
Wizard” appears. In this case, cancel the wizard by pressing the [Cancel] button in the wizard
screen and then install or continue the installation of DSS Player software.

You can directly connect the recorder’s USB terminal to your PC, or use the cradle included in
the package (desktop holder).

Connecting to Your PC Using the USB
Cable

Turn ON the recorder (= P.17).

Insert end A of the USB cable to
your PC’s USB port or USB hub.

Make sure the recorder has

stopped before attaching end b

of the USB cable to the terminal
port of the recorder.

If “REMOTE” is displayed on the
recorder, it indicates proper connections.

Once you connect the recorder to your PC, the recorder will
be powered through the USB cable. The batteries and/or
AC adapter will not be in use.

Notes

* NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If
you do, the data on the card will get destroyed.

* Some PCs and USB hubs may not supply sufficient power and the recorder fails to connect. Refer to your
PC User’s Manual regarding the USB port or USB hub on your PC.

* When using a USB hub to connect the recorder, always use a self-powered (AC adapter) USB hub.

* Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.
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Disconnecting from Your PC

Click the %> on the task bar
located at the lower-right corner

of the screen. Click [Safely __ R

Remove Hardware]. T
It will read [Stop USB Disk-Drive] for

Windows Me. The drive letter will differ

depending on the PC being used.

Disconnect the USB cable.

9d INOA 0} UOI}PaUUOD =

Move the icon of the recorder's drive displayed on desktop to trash box by
drag and drop.

Disconnect the USB cable.

Remove the Recorder from the Cradle

To prevent damage or loss of the data, confirm that the recording/playback indicator lamp of
this recorder is not on, and remove this recorder and USB connection cable from the cradle.

Notes

* NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If
you do, the data on the card will get destroyed.

* Some PCs and USB hubs may not supply sufficient power and the recorder fails to connect. Refer to your
PC User’s Manual regarding the USB port or USB hub on your PC.

* When using a USB hub to connect the recorder, always use a self-powered (AC adapter) USB hub.

* Make sure t the cable nne tor all th therwise, the recorder not operate proper!
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Connecting to Your PC Using the
Cradle

Insert end A of the USB cable to your PC’s USB
port or USB hub.

Connect end b of the USB cable to the cradle.

Turn ON the recorder, then set the recorder in
the cradle.

If “REMOTE?” is displayed on recorder, it indicates proper
connection.

(2]
o
=]
]
[
Q
(=4
o
H]
-
o
<
o
<
=
°
(9]

Notes
* Never touch the contact points at the bottom of the cradle, as that may cause bad connection.
* With a PC connected, the recorder cannot be operated with the foot switch (RS25/26). When connecting

the recorder to a PC via the cradle, remove the foot switch.
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Running DSS Player

By default, connecting the recorder to your PC, will start the application automatically.

| Disabling automatic start |

Right-click the Device Detector icon @in the System Tray in the lower right-
hand corner of the screen, then select “Settings startup application”.

Click [DSS Player Pro].
The check mark on [DSS Player Pro] disappears.

2

3

) 1 Start Windows. L é,m :
m & Dictation Module

E . " el R windows Update

2 Click the [start] button, then select [All C— @ pesores :

& [ Programs]. @ v vmor

All program menu will be displayed.

Select [Olympus DSS Player Pro], then
click [Dictation Module].

AllPrograms |

Note

If you connect the recorder before installing DSS Player, the “Add New Hardware Wizard” dialog box will
open. If this happens, click [Cancel] to exit the wizard, then install the DSS Player software.

58
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Start your Macintosh.

‘ ww [
Connect the recorder to your PC. ﬁ Lg g m
For cable connection instructions, see I = Pt
“Connecting to Your PC Using the USB [ " ® ,
Cable” (= P.55). e
Double-click the [DSS Player for | @ Q 8 |
Mac] (OS 9.x)/[DSS Player] (OS X) — s 15 =
folder.

The DSS Player (for Mac) folder opens.

Double-click DSS Player. e e
DSS Player for Mac (OS 9.x)/DSS Player —_—

Plus (OS X) launches. 0 [T =

For the OS X users: “The user’s registration
screen” is displayed when first launched.

Register user information (OS X).

The user’s registration screen will be -
displayed at the time of initial startup.

Please input the serial number.

Please see the seal attached to the CD-

ROM package included with the DSS

Player, for the serial number.

After the input has ended, click [OK] to

complete the registration.

N

Note
The Mac version DSS Player does not have the automatic start function.
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Window Names

2 Dictation Module - Download Tray\Folder A\DS330001,dss B

Fie Edt View Tools Download Voice Recogntion Help

P B X E Bl DY B D
S e e e
®_{ L e | > i

5]

*Main screen is displayed

v e a when DSS Player is started

s )
G0)| “roow | S

el - W & F -

= 55 oictaton Felder
= @ Download Tray

Work Type

& sent hems

U () Documents
Device Manager

= 0 pm s

9

FOLDER D
FOOERE (I

Total of 3 messages

sawieN MOpUIM =

@ Playback Control Bar

Provides the control buttons to play and stop

dictation files.

(@ Dictation Tree View

o
s
Ol o T um

CrostedDate  CompletedDate | Record. Comment _Transc. Do

1212320 0:00:08

12/24/2003 6:29... 12/24/2003 6:30... 0:00:11

Lengih

=

Dictation Window.

vou|seexol

866 —
[0 1[8] [oe] o] =] @] 80| B[54l v] & [0 &1

< [ oicaton flder Geaoaoate | Competed e
|98 05530001 5s 04032005 100011 04052005 10:00:4

) oovnload Tray
W ol 05330002455 0403.2005 10:01:0.. 04.03.2005 10:01:1
Q Folders 0533000345 04032005 10:01:3.. 0403.2005 10:01:4
0533000465 0403.2005 10:020.. 0403.2005 10040,

Q foere
Q rodero
Q foere

03 essoe Troy

Length Comment |4
000015
00005 7
0005 7
00033 7

T |
7

= B oevce vianarer
B 0s-3300 (053300)
Q rouvera
Q rowere
Q rowoere
Q rowoerD
Q roweme

Total of 4.

(3 Device Tree View
Displays the directory structure of the folders
in the recorder.

(@ Dictation List View

Displays the directory structure of the DSS,
WAVE (Windows only) and AIFF (Macintosh
only)-format files stored on your PC’s hard disk.

60

Displays the dictation files in the folder selected
in®@ and ®
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Download Dictation Files from the Recorder

There are 3 download options to transfer dictation files from the recorder to the PC:
* Download Selected Files
Download one or several dictation files to your PC.
* Download Folder X (X is any of the seven folders A to G)
Download all the dictation files in one folder.
* Download All
Download all the dictation files stored on the recorder to your PC.

The following is an explanation of “Download Selected Files”. For explanations of “Download
Folders” and “Download All", refer to Online Help.

Select the folder. e
From the Device Tree View, select the folder that =% oo-3500 (o300
contains the dictation file you would like to download. —ly
The illustration shows that Folder A is selected. Eﬂ:eri
older
Folder D
Folder E
Ei:] Folder F
Ea Folder G
<
Tatal of 3 messages

Select the dictation file.

Select the dictation file you would like to 2 *» | W Wttt %
download from the Dictation List View. To )
select more than one file, hold either the
[Ctrl] or [Shift] key and select desired files.
The illustration shows that one dictation
file is selected.

File Name Author ‘Work Type Created Date

L 12}24/2003 6:30..
(4] D5330003.dss  D53300 12/24{2003 £:29..

19pJ099Y 8y} Wouy saji4 uonedig peojumod
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Download the dictation file.
From the [Download] menu, click
[Download Selected Files].

Download complete.

Do not disconnect the USB cable while
the record/play indicator lamp on the
recorder is flashing. Disconnecting the
USB cable when the recorder indicator
lamp is flashing will result in data loss or
corruption.

You can change the download destination folder
by changing the folder properties in the Download
Tray. Right-click the folder and make the
necessary changes under [Properties].

To change the download options and filename
format, check the [Tools] menu, [Options].

Notes

# Dictation Module - DS-3300 (DS3300)
File Edt view Tools

Voice Recognition Help

Download Folder A

Download Folder B & -

Downioad Folder C

i Length
Lo || ™ nefodeD 0§ cooo |

J DowsdFodet = |

Devinload Folder F al)
000 Dovnioad Folder G

WorkType  Crested Date

Ctrktshift+M

Folder | Edfi & Upload Templates... Ce+T
Folder D
Folder £

EEEEDSS
2 D24V Download Al

LA Folder &

é Folder &

Create &5end Job Data...

Set Recorder Menu

Downloading

to 'Folder &'
DS330002.dss
[ ]
Cancel
Remaining 3539 K bytes

* NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.

* Depending on the size of the dictation file and your PC, it may take some time to download the files.

* The downloaded files will be stored in the download tray folder that corresponds to the folder in the recorder.
(Example: A dictation file downloaded from Folder A will be stored in download tray A on your PC.)

« If a dictation file already exists on your PC with the same name, date and time recorded, the new file will

not be downloaded.
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Playing a Dictation File

Select the folder.
Select the folder where the dictation

file resides.
Select the dictation file. << | | B i i
Select the dictation file to play from ]
the Dictation List View.
Play the dictation file. = oo Vi :

= y ' M Auth
Click the [1® | (play) button in the @ Folder & BT i . 0
Playback Control Bar or double-click Folder B e
the file. T

Other playback control bar such as Rewind, Fast Forward, Stop, Speed Control, Volume Control,
Time Axis and Index Skip are also available on the Playback Control Bar.
The DSS Player can playback voice through the recorder speaker. The recorder must be

connected to the PC, and the USB Audio feature must be enabled on the recorder. See “USB &
Microphone/USB Speaker” (== P.76). s
«
o
File Name Format =]
File names are assigned in the following manner. %
DS330001.dss S
[ i o
Extension 5
File number ...... A serial number automatically assigned by the recorder.
Author ID...The ID that has been set on the recorder. The default ID is “DS3300”. The Author ID
can be modified with DSS Player (== P.66).
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Upload Dictation Files to the Recorder

DSS Player enables you to upload DSS dictation files from your PC to the recorder.

Select the folder.

# Dictation Module - Download TrayiFolder ADS330001. dss

Select the folder where the dictation file TR TTEE T
to upload resides. = 0 Dowrlozd Folder A ¢
Download Folder &
Select the dictation file. = — I st e
Select the dictation file to upload from the ] Dowrload Foider £
Dictation List View, then select [Download S
menu, then [Upload Files] or click the |4 [ &3 Ditstion Folder | Downlosd Selected Files i
icon in the toolbar. [EE - Duan\cl.;d T:. Download Al Ctrl+Shift+M
olaer
. . A B .
Select the destination upload %. e B A e
HYlder D

folder on the recorder. -y Flll e St
When the folder list box appears, select %: ert | sateclder s
the folder then click the [OK] button. @ resfoerey | 0L dss D

& outtfx 7 D533000248cs 053300

1By Sentfrems 7 1${D3330003 s DS3300

Docrfnts
Upload complete.
Once the transmission screen closes and

the record/play indicator lamp on the
recorder is NOT, upload is completed.

As a shortcut, you can drag and drop files
from the Dictation List View to the recorder’s
folders displayed in the Device Tree View.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

19pJ099Yy ayj 0} 9|14 uone}dig peojdn H
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Direct Recording/Editing on PC

You can easily record on the PC directly using the recorder and the DSS Player. While the recorder is
connected to the PC with the USB cable, the Remote Dictation window in the DSS Player allows you to
create a new recording or edit an existing recording. The recorder will act as a sophisticated microphone
with the buttons controlling the recording or editing process. See the Online Help for details.

# Remote Edit - FolderA\DS330002_1.dss. : Remote Edit
Fle Edt Tooks Hep | Newindex | 7y Delete inden | ¢3¢ erase Range | 2@ Erase | Lf ena |
DE = v 9w B U Position Length ] prionty B
Bt Lergh iy Wark Type | ooooo | Cosert Recording. Sy
[inset recording i —_— =
T " Cwm [ DT
O J e R e
! :
| Recording a new file | Editing existing files |
From the DSS Player main window, From the DSS Player main
click the [File] menu, then select window, select the file you want
[New File], or click the ﬁl icon. to edit from the Dictation List View.

[Remote Dictation] window appears. . )
Click the [File] menu, then select

Press the [ ®& | (record) button in [Edit File], or click the ] icon.
the [Remote Dictation] window or [Remote Dictation] window appears.
press the REC button on the

recorder to start recording. Edit the recording using the

recorder buttons.
Press the | = (stop) button or You can use the mouse connected to your

press the STOP button on the PC and the Record and Playback controls
. to edit recordings.
recorder to stop recording.

Notes

« If you open the [Remote Dictation] window while the recorder is connected, the function of the recorder is
changed to Audio device from Storage device automatically. The recorder as AUDIO device is not displayed
as a removable drive on your PC. Closing the [Remote Dictation] window and returning to the main
screen will switch the recorder back to storage class device displayed as a removable drive.

* You cannot edit WAV files.

* For DSS Player for Mac, the editing functions are partially limited.

* The maxim recordipg time per file is 99 haqurs.
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Changing User ID (Author ID)

User ID can be uploaded to the recorder using the DSS Player. Up to 10 IDs can be uploaded

to the recorder.

From the main window, click the
[Download] menu, then select [Create &
Send Job Data]. The [Create & Send Job
Data] window appears.

Enter your user ID in the field indicated by the
arrow.

Click the [Transfer] button.
The new user ID will be transferred to the
recorder.

Create and Send Job Data X
05-3300 Pty Level
AutharlD. .
rl\ I il -
Ja r
= 'S r
rr——— §r -
r ’7 || r ’7
Vs TpeiD [al] [ 5]
In m o |
o m - |
r ’7 || r ’7
o m O ]
o H O ]
Save Transter
Transfer NggID
=/
f r—— Y
. Cancel

Note

NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you

do, the data on the card will get destroyed.
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Changing a Folder Name

The folders in the software and recorder can be renamed to reflect the type of recording they
will contain. For example, Folder A might be used to store private information and thus be
renamed PRIVATE, while Folder B might be dedicated to holding business information and
thus be renamed BUSINESS.

Changing a folder name in the software
You can change a folder name in the Dictation List View using the [Rename Folder] command
from the [File] menu. A folder name can be up to 20 characters long and cannot use \ /
s,

Changing a folder name in the recorder
Right-click the folder in the Device Tree View to be renamed, select the [Rename Folder]
and input the new folder name.

The name of the folder on the recorder will be updated with the new folder name automatically.
Device Window folder names consist of a string of 8 or fewer alphanumeric characters.

Editing File Comments

You can use your DSS Player to create/edit comments, then transfer them from the PC to the
recorder. You can also edit file comments imported from the recorder to a PC.

Click the [Tools] menu, then select [Edit Comment].
File comments can use up to 100 alphanumerical characters and symbols.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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Using Voice Recognition Software (Optional)

Audio set up

When using voice recognition software such as IBM ViaVoice with the DSS Player, it is
recommended that you train your voice recognition software first to learn the characteristics of
the speaker’s voice and the recorder’s built-in microphone for maximum accuracy.

Connect the recorder to your PC, and start the DSS Player.

Change the recorder to AUDIO device.
Follow the procedure in P.76 to change the recorder to AUDIO device.

Click the [start] button, select [All Programs], then select [IBM ViaVoice
VoiceCenter].

[ ViaVoice User Wizard

From the [IBM ViaVoice VoiceCenter],

select [ViaVoice], [Tool], then [Analyze
My Voice]. The ViaVoice User Wizard
window appears.

From the [Device] list box, select
[Olympus DSS File] or [Olympus
WMA File].

Select [Olympus DSS File] or [Olympus
WMA File] in the [Device] list box, then click
the [Next] button.

Click the [Next] button.
The [Audio Setup Wizard] window appears.

Welcome to the User Wizard

Fleass tyne & desaription for your voice madel, or select one
ram the Voice Mode list

User Mame:

DS-3300

Device:

“oice Model

Langusge:

UK Englsh
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Select a sound_ card. . Selecting a Sound Card
When the [Selecting a Sound Card] window P ——
. . ple sound cards in pour spstern.
appears, select [USB Audio Device] for Select the cads to use for Viavaice.
[Input] and follow the instructions on screen.
(Select [Microphone Control (DVR)] for Sound Cards
Windows XP.)

Input;

Proceed with the AUDIO Setup
according to the instruction on

screen.
During audio setup, enroliment, please input
voice data from the recorder.

Output:
Speaker Controll DR j

It is recommended that you enroll while in your normal surrounding environment settings.
This will help improve the voice recognition by registering your voice characteristics and your
environment.

Notes
* Windows 98SE or later OS is required when using voice recognition function with the recorder.
¢ DSS Player for Mac is not compatible with IBM ViaVoice on Macintosh.
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Executing Voice Recognition

The DSS Player provides a link in the menu for IBM ViaVoice Voice Recognition software. You
can easily access the menu and initiate voice recognition on any of the DSS file in the Dictation
List View.

Select the folder.

Select the folder COntaInIng the File Edit WYiew Tools Download Yoice Recognition Help
dictation file you want to process with b X =2 bh O Lo
voice recognition from the Dictation | = > | Posiion Lenath M\
Tree View. 3 NN e
Select the dictation file. =
. . N . B Dowrload Tray ] Name Author work Type | (Jeate
Select the desired dictation file to Fober &
process with voice recognition from Folder < N ey b
the Dictation List View vl : . T
. Folder
) . (P Folder F
Start of voice recognition. Py ek
Click the =) icon. %gut::
The voice recognition software 5 Docrents
window appears and voice recognition [ N e—
starts.

|Noise Canceling Function |

Check [Use Noise Cancel] in the [Voice Recognition]
menu to output voice using the noise canceling function
to the voice recognition software.

Download Tray\Folder, AADS 330001 . dss
Download & (N Help

& Start Yoice Recognition =
Woice Recognition Range

Check the voice recognition software operating manual L e Cancel
for voice recognition functions such as modifying converted ————  Automatic Playhack N |
characters. Shaow Progress

(reuondo) asemyos uoniubooay asiop Buisn H
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Notes on Recording For Voice Recognition

When recording voice to be
processed with voice recognition, set
up your DSS recorder as follows to
improve recognition accuracy.

* Set the microphone sensitivity to “DICT.”
(= P.27).

e Set the recording mode to “SP”
(= P.28).

* Set the Variable Control Voice Actuator
(VCVA) to “OFF” (x= P.29).

* Register/enroll your voice in the voice
recognition software using the recorder.

* Record in a relatively quiet environment.

* Have the recorder microphone 5 to 10
cm (2 to 4 inches) away from your chin.

* Speak normally.

¢ It is recommended to use the noise-
cancellation microphone, ME12, when
recording.

Dictation files recorded under the
following conditions cannot be
processed by voice recognition
because their recognition accuracy
rates will be very low.

* A conference or meeting where many
voices are recorded.

* Seminar or lecture where high-level
ambient noise tends to be recorded.
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Joining Files

In DSS Player, designated multiple voice files can be joined and one voice file can be created.

From the Dictation Folder Window, select
the folder which contains the files to be

1 Select the folder.

joined.
2 Select the voice files.

From the Voice File List Box, select more

than one file to be joined.

Select [Join] from the [Edit] menu.
The dialog to join files will be displayed,

listing the files selected in step 2.

#- Dictation Module - Download Tray\Folder AADS332

e e B

File Edit view Tools Download Voice Recognition Help

v @ X E

Br T O
»|»‘

0.00

005

= 3 Dictation Folder

=By Dowrload Tray
Folder A

e

4 Message Ty
3 outhe:

B4 Sent Items
Documents

File Name ‘
[%]D3332290.055 D
[ D5332291.055 Dt

=

Dictation Module - Download Tray\Folder, A

File Naud® View Tools Download Woice Recogrition |

e

=E

Cut Chrl+%
Copy... Chrl+C
Select All... Chrl+4
Delete... Chrl+D

Move ko Folder, ..

Br O
T

0.05

File Name

3

7o InE[DEEEZ290,
7 hE[Ds332E91.
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Set the order of files. Join files X
After joined, the playback order of the files Joins fles
can be changed. Select a file, and move L] et et s s

the file to its appropriate position in the order Lo o e e teearded v the same cerding mode as e s
using the [Up] and [Down] buttons. B | Gzmmle, | ot | Mol
000 5 nono| 0:00:10

0002 D3332294D55 SPimong)  C:00:0] D53300

|nput File Names. 0003 D5332295D55 SP(mono] 00 DS3A00
The file name is created automatically after
joining and also, it enables input optionally.

Press the [Join] button.
The resulting file is saved under the name >l @
specified in step 5, and stored in the Ao Riecodng |  C228
selected folder. [psezzzncoss \ |
) o
A

I 1 N

sa|14 Bujuiop u

Notes

« If the files to be joined have different recording modes, the mode of the file listed at the top is selected.
* The Joining Files function is not available for the OS 9.x.

73

Download from Www.Somanuals.com. All Manuals Search And Download.



saji4 bunuds H

/4

Splitting Files

One designated voice file can be split into the two files in DSS Player.

Select the folder containing the file to be split

1 Select the folder.
from the Dictation Folder Window.

Select the voice files.
Select one file to split from the Voice File List
Box.

Select [Split] from the [Edit] menu.
The setting dialog of the file to be split will be
displayed.

J

# Dictation Module - Download Tray\Folder A\DS332290.DSS

File Edt view Tools Download Voice Recognition Help

) ]
kbl

g B

Position |

Pl B O X | E D

< | m | » [

0.00
= g Dictation Folder [}

5 Downlaad Tray
Folder A

Foldsr Ef
FDIdEr
(R Entdas v

Dictation Module

w#]D533zz 3055 DS3a00

2

- Download Tray\Folder A

8 Yiew Tools Download Voice Recognition  t
Cut Chrls

=

€ copy... Chrl+C Bs [
Select All... Chrl+a J | ] 3 »
Delete, .. Chrl4+D
Mowve to Folder. ..

0.05
Fie Name
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Split File X

Splits 5 file.
Entter the split file name and split positan,
Input file name: Recording fime
Input file name ——| |psaszeannss | CER
(Fll_e name before Output fls name-
splitting.)
Fitst half |05332290_A.DSS | 00004
OUtPUt file name D5332290_B.DSS 00c.o?
. . I,
(File name after Lot | | - |
splitting.) Splt pasition
|—— Split position
0:00:00 00o:11 (Tlme aXIS)
| Playback / — =le
[=| Stop button
The display wil TR ———
change whenever the
button is pressed. I

Playback slider
Shows the current playback position
and split position.

Set the split position.

Press the »| button to playback the file, and press the | =| button in the position to be
divided.

Also, the playback slider position in the time axis shows the current playback position, and
also shows the split position (slide the playback slider to the right or left, which enables
moving to the position to be split).

Input File Names.

The file name is created automatically after splitting and also, it enables input optionally.

Press the [Split] button.

The splitting of the file will complete, and the file name designated in procedure 5 will be
saved.

Note
The Splitting Files function is not available for the OS 9.x.
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USB Microphone/USB Speaker

The recorder can be used as a USB speaker or microphone when connected to a PC. If you use the
recorder as a USB speaker, you can output voice through the recorder instead of using the PC speaker.
When used as a microphone, you can record voice on your PC using you favorite application.

Click the él icon in the toolbar to change the recorder to Audio device.

{ Vacintosh JeRRY

From the [Tools] menu, select [Change to audio device].

Notes

* USB audio function cannot be used with Windows 98 or Mac OS 9.x. The USB audio function is available
only with Windows 98SE and later versions or Mac OS10.1.5 and later versions of OS.

¢ For Mac OS, 0S10.1.5 or later versions support the USB speaker function only. Mac OS10.2.7 or later
versions support the USB microphone function as well.

« If you switch the recorder to Audio device, the recorder does not function as Storage device, and it is not
displayed as a removable drive.

* The recorder does not work as USB speaker when using the direct recording function with the DSS Player.
When the [Remote Dictation] window opens, the PC speaker will be the output device.

Download from Www.Somanuals.com. All Manuals Search And Download.



Sending Dictation Files/Receiving Document Files

DSS Player software can send dictation files to a third party by e-mail or FTP.

This process can be automated by configuring the DSS Player with the recipients profile
information and the sending method.

Setting the E-mail/FTP Service

E-mail/FTP service needs to be set to send/receive files.

When using E-mail and/or FTP to send dictation files attachments and/or retrieve typed
documents, it is important to configure the E-mail/FTP service in the DSS Player to match the
E-mail/FTP program you have configured on your PC. Please consult with you system
administrator if you need help with setting your E-mail/FTP service.

From the DSS Player main window, click the s m—
[TOOIS] menu, Select [OptiOnS]’ then click the General | Download | EmalFTP | Send | Receive | Backup | Folders
[E-mail/FTP] tab. E-mail service Option
Email
Create a profile which specifies the sy C—
destination. SMTF/POP3 Profile: | olvmpus. Vr
A profile must be created for each account to be e L
connected. Nates, Grauphuise ot any other MAPI canpiant e-mall sanvice
To create a profile, select the sending method, and e
click the [Setting] button.
FTP -
When E-mail is used to send and/or receive files, G .
select the type of E-mail service used on your system.
Internet E-mail

Select when using E-mail, connecting to POP3 or
SMTP server via internet service provider.

so|14 Juawnooq Buiniddey/sa|i4 uoneloiq buipuss u

| Corporate or Workgroup

Select when using MAPI Compliant services such as Microsoft Exchange, Lotus Notes or
Group Wise. For details on the setting procedure, see P.78.

Select a profile.
When the setting is complete, click the [OK] button to enable the setting.
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Setting Connection for MAPI Compliant Service

Click the [start] button of Windows OS, select [Settings], then [Control Panel].
The [Control Panel] appears.

Check whether the [Mail] or [Mail and Fax] icon @ is present in the Control
Panel.

If the icon exists, the MAPI subsystem has already been installed on your computer. Go to the
“Activating Send Mail Function (Create a Profile)” section in this manual (== P.82).

If the icon does not exist, install the MAPI subsystem. The MAPI subsystem will be installed
when Microsoft Exchange Client, or Microsoft Outlook is installed.

Microsoft Outlook is included in the Microsoft Office.

Installing MAPI Subsystem

| Installing Microsoft Outlook 98 |

Start the Setup program for Outlook 98.
When the following window appears, select [Other
Mail Applications] and click the [Next] button.

When the following window appears, select
[Corporate or Workgroup] and click the
[Next] button.

sa|14 Juawnooq Bulnleoay/sa|i4 uoneoig buipuasg H

Follow the instructions on screen.
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| Installing Microsoft Outlook 2000|

After installing Outlook 2000, start the
program.

When the following window appears, click the
[Next] button.

Outlook 2000 Startup

‘Wekome to the Outlook 2000 Startup wizard, wich il gude you
through the process o corfguring Outlook 2000,

Select [Corporate or Workgroup] and
click the [Next] button.

E-mail Service Options

 temetonly
‘Optiize Outiook o cornect ooy o ane o more Inernet
Servie Providers or Emal Servers ushng Intamet standarcs
fore-mai delvery (POPS3, TP, o IVAP).

n
‘Confiure Oulock to connect to Micosoft Exchenge,
by ooy

A dialog box for setting up Microsoft
Outlook appears. o | oo | oo | e |
This is the wizard for creating a profile. For
information on creating a profile, check step 3
in the “Activating Send Mail Function” (== P.82).

| Installing Microsoft Outlook XP/2003 |

After installing Outlook XP, double-click
the [Mail] icon in the [Control Panel], and
then click the [Show Profiles...] button.

., Change settingsfor the fles Outook uses
tostore - o5 and documents,

Data Fls;

s9|14 Juawnaoq Buinleosey/saji4 uoneloig buipuasg u

Q Setup v

and data e, Typicaly, you el need

ane. RSt yeseny Show Proies
ciose
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Click the [Add...] button.

Type the profile name and click the [OK]
button.

Select “Add a new e-mail account” and
click the [Next] button.

Select your e-mail server type.

If you are going to use an MAPI compliant
Workgroup system such as Lotus Notes or
Novell GroupWise, select “Additional Server
Types”, click the [Next] button to continue. If you
are going to use an internet standard E-mail
account, select “POP3” server, click the [Next]
button, and skip to step 7.

Sl | o) | Heb
B
Ok
W crosorion vt [ |
Cancel
Profile Name:
lLotus Motes|
X
B s
21X
Server Type <

€ Microsoft Exchange Server
shar

€ pop:
Connect t 3 POP3 a-ma server o domniosd
your emal.

€ e

malbox flders.
© hrre

synchvonize malbos folders.
& Additional Server Types
Connect to ancther workgroup or rd-party ma server,

<Back Cancel
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If you select “Additional Server Types”,
you will see the following dialog box.
Click the [Next] button and follow the instructions on
the screen, then skip to step 8.

If you select “POP3”, you will see the
following dialog box.
Enter the necessary information and click the
[More Settings...] button.

Click the [Connection] tab in the following dialog
box and make sure the appropriate connection
method is selected.

After the setup is completed, click the
[Tools] menu, select [Options], then click
the [E-mail/FTP] tab. Select the MAPI
profile name you have created.

Additional Server Types

dticnal ool server types, Selctthe
connect to and ck ext

Tnte ttings (POP3)
Eath of these sttings e required 0 ge your &-mal accourt working.

User Information

Server Information

Yourame:— [ohymes
Emal address:

iog re passmer
Auhentaton (5PA)

Concel

Cance
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Activating Send Mail Function (Create a Profile)

The Profile is the group of information services to set up the Messaging application. The
information services allow you to access the Mailbox and the Address Book. The Send Mail
function will not work if there is no profile. If the profile exists and has already been used for
sending E-mail, it is not necessary to create a new profile.

Start the DSS Player and click the [Tools] menu, select [Options].

In the Option Setting dialog box, click the [E-mail/FTP] tab and select the
profile name you want to use.

Click the [Setting] button. Microsoft Outlook Setup Wizard
The Setup Wizard runs and will list the
messaging applications that comply with
MAPI. For example, if groupware such as
Lotus Notes, Novell GroupWise, or
Microsoft Exchange is installed, these
applications will be listed.

Select the infomation servicsls) that you want to use:
with Microsoft Dutlook.

" Use the following information services

I Microsolt Exchange Server i
¥ EIntemel Emal oo

Select [Use the following information
services] and check one application

from the list. _ _ ]
If you want to set up a dialup connection
through an internet service provider, select
[Internet E-mail] in the list. If you want to
set up to use a LAN within your company,
also select [Internet E-mail] in the list.

£ Manually configure information services

Cancel

Note
The Send Mail function does not work with AOL or internet service providers that cannot open
POP3 server addresses.

sa|14 Juawnooq Bulnleoay/sa|i4 uoneoig buipuasg H
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Click the [Next] button and follow the instructions on the screen.

When the wizard is complete, it returns to the profile in the Option Setting
dialog box.

Please make sure that the profile name you have created using the Setup Wizard
is displayed in the Option Setting dialog box. If a different profile name is displayed,
switch to the profile you have created.

Setting the Auto-Sending Function

To send downloaded dictation files automatically, follow these steps to set the auto-sending ﬂ
function. This function can be individually set for the folders in the Dictation Tree View.

[72)

[}

2

From the [Tools] menu, select [Options], Option B 32
then click the [Send] tab in the Option e 2
dialog box. = g
a o

Check [Enable auto-sending function]. 2
.

v e

R < > )

Select a folder to set the auto-sending S §
function, and check the check box. 10 ‘ <
c =1

. BCC «Q

Select the sending method. e =]
i H 1 H end to destinations o
g(ljlglr(etstwse [E-mail] button for selecting an E-mail 5 - %
ClICk the [FTP] button for SeleCting an FTP [T Display sending information ir the Falder tool tip J g
profile. n
o

(7]
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|Setting the E-mail destination |

Click the [E'ma“] button. Set e-mail destinations
The [E-mail destination] dialog box appears.

Subject: |

Note

The [Select recipients] dialog box appears.

2 Click the [To] button.

Select the recipient names from the TS B
Address B°°k' A‘:ud:: = E-Mail Address T0:2 M‘:;i:mﬂ‘e"‘s

At least one recipient is required in the [To:->] field. panss  peeGA

The [CC:->] and [BCC:->] selections are optional. £ I
Click the [OK] button to finish. If the recipient T | R

information is not present in the Address Book, use " -
the [New Contact] button to add new contact — —
information to the Address Book. 8 | @

| Setting the FTP destination |

Click the [FTP] button. FIP distinations
The [FTP destination] dialog box appears. Name | FPAddess | Logi. | Auolies fode

[~

| 5

Click the [To] button.
The [FTP Profiles] dialog box appears.

sa|14 Juawnooq Buinleoay/sa|i4 uoneloig buipuas H

One profile can be selected. Click the [OK]
button to finish. If the correct profile does not
exist, select the [E-mail/FTP] tab in the Option
dialog box, and add the profile file for the FTP
connection.

3 Select a profile from the list. pr—
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Setting the Document File Retrieve Function

From the [Tools] menu, select [Options], then click the [Receive] tab in the

Option dialog box.

Check the [Use collect back documents
functions] check box.

Select a protocol to be used for receiving
a document file.

If the transmission profile setting is not configured,
configure the setting in reference to P.77.

Register the format of a document file to
receive.

When using E-mail to receive a document file, the
application (software) receives the attached file if it is in
the registered file format.

When using FTP to receive a document file, the
application (software) receives the attached file stored in
the folder of destination server if it is in the registered file
format.

option 3]
General | Download | E-mail/FTP | Send REDE‘VE_BEEKUP Folders

“ith this L, the application wil back
the ransorbed documert and ik the document to oriainal dictation.

Use eolect back documents functions
Frotocal to receive documents
[TEnable E-mail
[Enabie FTP

Type of documerts to be received

[ Receive dacuments sent by an appisation other than DSS Player
Addthe extension for the file o be received

{
Display color is changed if Document is not sentback
| [ ahter the folloviing days since distrbution of Dictation |
have elapse:
|
|
|

Any document file associated with a dictation file sent from a transcriptionist using the DSS
Player Pro Transcription Module Release 4 or later is received regardless of this setting.
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Sending Dictation Files

|Sending Dictation Files Manually |

Select the dictation file you want to send from the Dictation List View.
To select more than one file, press and hold either the [Ctrl] or [Shift] key and make your
selection.

Right-click the dictation file, and select [Send File].
Select E-mail or FTP for the sending method.

Confirm the contents of the transmission template, and click the [Send]
button.

| Receiving Document Files Manually|

In the toolbar, click the [Send/Receive files] icon Ql .

According to the profile set, the application establishes a connection to the server and receives
document files. The received document files are saved to the Documents folder in the Dictation
Tree View.

Clicking the [Display Dictations & Documents] icon [&| in the toolbar displays dictation files and
document files at the same time. By dragging and dropping a document file to a dictation file,
the document file can be associated with the dictation file.

The document file sent as a reply from a user (transcriptionist) who uses the DSS Player Pro
Transcription Module Release 4 or later will be automatically associated with the dictation file
you originally sent to the user.
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Sending/receiving Automatically

You can set the application to make a connection to the server at the certain interval for sending
dictation files and/or receiving document files.

From the [Tools] menu, select [Options], then click the [General] tab in the
Option dialog box.

Check [Auto-send/receive], and enter the time interval of automatic attempts
of sending and receiving.

Set the auto-sending function and the document file retrieve function
according to the instructions on P.83-85 respectively.

Dictation files are stored in the Message folder on the hard disk. If you want to send a dictation
file by attaching it to e-mail, select the file from the Message folder.

The Message folder location can be found by selecting [Options] from the [Download] menu.

Playing Received DSS Files

When sending DSS files to a user who does not have the DSS Player software, the user will
not be able to play the received DSS file. A free DSS Player from Olympus, DSS Player Lite,
can be downloaded from the Olympus website at:

http://www.olympusamerica.com/cpg_section/cpg_downloads.asp
http://olympus-europa.com/consumer/2590_software.cfm
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Using the Recorder as a Reader/Writer

When the recorder is connected to your PC, it will be recognized on your PC as a removable
drive. You can view and access the recorder card from My Computer and download data from
the card to your PC using standard windows copy/move and delete commands. You can also
upload data from the PC to the card in the recorder in the same way.

¢ In Windows 98/ 98SE, you must have the DSS Player software installed for the recorder to be recognized.

Example: Copying Data from PC to Card Using Explorer or Finder

Start Windows.

Connecting the recorder to your PC.
For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (= P.55).

Open Windows Explorer or Finder window.
The recorder will appear as a removable drive icon.

Copy data to card.
While the data are being written or copied, the record/play indicator lamp on the recorder
will flash.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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Alarm Message List

Message Meaning Explanation Action

BATTERY LOW  Low battery Battery power is getting low.  Charge the battery or replace
power with new batteries (r= P.13-15).

FILE Erase-locked Attempt to delete a locked Unlock the file (= P.39).

IS LOCKED file.

INDEX FULL Index full The file is full of index marks  Erase index marks that are no

(maximum of 16 marks). longer required (r= P.40).
FOLDER FULL Folder full The folder is full of files Erase unnecessary files (== P.33).

(maximum of 199 files).

Maximum number

The destination folder
already has the maximum
number of files (199).

Erase unnecessary files (= P.33).

MEMORY
ERROR

Incompatible card

An incompatible card was
inserted.

Insert a compatible card.

MEMORY FULL

Zero remaining
memory

The card has no remaining
memory.

Erase files that are no longer
required or insert another card.

FORMAT Formatting error There was an error while Reformat the card (s P.47).

ERROR formatting the card.

SYSTEM System error System error detected in the  This is a malfunction. Contact

ERROR recorder. the place of purchase or
Olympus Service Center for
repair.

INSERT CARD No card There is no card inserted. Insert a card (== P.21).

CARD COVER  Card coveris The card cover is not closed.  Close the card cover securely

IS OPEN opened until it click (= P.21).

Download from Www.Somanuals.com. All Manuals Search And Download.

1s11 abessay wely l

89



~
Bunooysajqnoir

90

Troubleshooting

Symptom Probable cause Action
Nothing appears The batteries are not loaded properly. Verify polarity is correct (== P.13-14).
on the display The batteries are dead. Charge the battery or replace with
new batteries (= P.13-15).
The recorder is in power off mode. Turn the recorder ON (= P.17).
Won’t start The recorder is in power off mode. Turn the recorder ON (v P.17).

The batteries are dead.

Charge the battery or replace with
new batteries (= P.13-15).

Unable to record

The card does not have enough memory.

Erase unnecessary files or insert
another card (= P.21, 33).

The card is unformatted.

Format the card (= P.47).

The maximum number of files has been
reached.

Check another folder.

No playback tone
heard

The earphone is connected.

Unplug the earphones to use the
internal speaker.

The VOLUME button is set to 0.

Adjust the VOLUME button.

Unable to erase

The file is locked.

Unlock the file (== P.39).

Noise heard
during playback

The recorder was shaken during recording.

The recorder was placed near a cell phone

or fluorescent lamp while recording or
during playback.

Move the recorder.

Recording level
too low

The microphone sensitivity is too low.

Set the microphone sensitivity to
CONF mode and try again (= P.27).

Unable to set
index marks

The maximum number of index marks (16)

has been reached.

Erase unnecessary index marks
(= P.40).

The file is locked.

Unlock the file (== P.39).

Cannot find the
recorded voice

Wrong folder.

Switch to the right folder.

Cannot connect
to PC

Some PCs and USB hubs may not provide

sufficient power.

Turn the USB CHARG. “OFF” in the
recorder’s menu settings (= P.37).

Cannot connect
toa PC using a
cradle

Sometimes a connection cannot be made

with some PCs running Windows XP.

You need to change the PC’s USB
settings. See DSS Player online help
for details (= P.54).
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Accessories (Optional)

PC Transcription kit: AS-4000

The AS-4000 transcription kit (sold separately) provides you with a PC-footswitch, a headset and DSS
Player Pro Transcription Module for easy transcription of DSS recordings.

xD-Picture cards of 16, 32, 64, 128, 256 and 512 MB: M-XD16/32/64/128/256/512
Olympus CAMEDIA digital camera series xD-Picture Cards can be used.

Headset: E61, E102

Stereo headset for your PC. A helpful tool for PC based transcription.

Monaural binaural earphone: E20

Noise-Cancellation microphone: ME12 (Dictation microphone)
Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
Recommended to improve the accuracy when using voice-recognition software.

External microphone: ME15
A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.

Ni-MH Rechargeable Battery Pack: BR402
High-efficiency rechargeable long life battery.

AC adapter: A511/D-7AC
Connect to the cradle to recharge the Ni-MH battery pack.

Foot switch: RS25/26
Connect to the serial or USB port of your PC for hands-free transcription convenience.

USB Reader/Writer: MAUSB-10 (Dual-Slot xD-Picture Card & SmartMedia)
Allows data to be transferred to and from a PC.

USB Reader/Writer: MAUSB-300 (xD-Picture Card)
Allows data to be transferred to and from a PC.

PC Card adapter: MAPC-10 (xD-Picture Card/SmartMedia)
Allows data to be transferred to and from a PC that has a PC card slot.

Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.
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Specifications

Recording format
DSS (Digital Speech Standard)
Recording media
xD-Picture Card: 16 to 512 MB
Input level -70 dBv
Sampling frequency
SP mode: 12 kHz
LP mode: 8 kHz
Overall frequency response
SP mode: 300 to 5,000 Hz
LP mode: 300 to 3,000 Hz
Recording time (32 MB Card)
SP mode: 5 hours 13 minutes
LP mode: 11 hours
Alkaline battery life
Recording: Approx. 20 hours
Playback: Approx. 12 hours
Ni-MH Rechargeable Battery life
Recording: Approx. 15 hours
Playback: Approx. 10 hours
Speaker
Built-in 828 mm round dynamic speaker
MIC/EAR jack
3.5 mm mini-jack, impedance MIC 2 kQ,
EAR 8 Q or more
Maximum working output (3 V DC)
220 mW or more (8 Q speaker)
Input power requirement
Rated voltage: 3V
Batteries: Ni-MH Rechargeable Battery
Pack (BR402) or Two AAA
batteries (LR0O3 or R03) or Two Ni-
MH rechargeable batteries
(BR401)

External dimensions
110.2 x 50.0 x 17.2 mm
(without protrusions)
Weight
101g
(Including alkaline batteries)

* Specifications and design are subject to
change without notice.
* Battery life is measured by Olympus. It

varies greatly according to the type of
batteries used and the conditions of use.
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Technical Assistance and Support

DS-3300 is part of the Olympus Professional Dictation System. Your dealer is trained to troubleshoot
and fix many common problems that you may be having with this system. If you encounter problems
using your DS-3300, we recommend that you contact your Olympus Professional Dealer that
sold you the system. If your dealer cannot fix your problem, please call our technical hotline
number or send an E-mail.

@ For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec @ olympus.com

4 For customers in Europe
E-mail : dss.support@ olympus-europa.com
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OLYMPUS'

OLYMPUS IMAGING CORP.
Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo 163-0914, Japan. Tel. 03-3340-2111
OLYMPUS IMAGING AMERICA INC.
Two Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A. Tel. 1-800-622-6372
OLYMPUS IMAGING EUROPA GMBH
(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. 040-237730
(Letters) Postfach 10 49 08. 20034 Hamburg. Germany.
OLYMPUS UK LTD.
2-8 Honduras Street, London EC1Y OTX, United Kingdom, Tel. 020-7253-2772
http:/ /www.olympus.com

For customers in North and South America

Declaration of Conformity

Model Number: DS-3300

Trade Name: DIGITAL VOICE RECORDER

Responsible Party:  OLYMPUS AMERICA INC.

Address: 2 Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A.

Telephone Number:  800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

C Tested To Comply
With FCC Standards
FOR HOME OR OFFICE USE
Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio émanant
d’appareils numériques, tel que prévu dans les Réglements sur I'Interférence Radio du Département
Canadien des Communications.

For customers in Europe

“CE” mark indicates that this product complies with the European requirements for safety, health,
environment and customer protection.

electrical and electronic equipment in the EU countries. Please use for the disposal of these types

of equipment with the available return and collection systems.
BN Applicable Product : DS-3300, Cradle P2-BZ8092-01
Download from Www.Somanuals.com. All Manuals Search And Download. AP0503

X This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste
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